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RNA 9000 Purity & Integrity Kit

The RNA 9000 Purity & Integrity Kit contains reagents and supplies for sample preparation and
methods to resolve RNA fragments by size and to quantify heterogeneity and impurities that
might exist in an RNA preparation.

This document gives instructions for sample preparation with the RNA 9000 Purity & Integrity Kit.
It also gives instructions for data acquisition and data analysis with the PA 800 Plus software.

Use the information in this application guide as a starting point. As required, change injection
time, voltage, injection type, or other parameters to find the best conditions for your needs.

Note: For instructions for safe use of the system, refer to the document: System Overview
Guide.

Safety
Refer to the safety data sheets (SDSs), available at sciex.com/tech-regulatory, for information
about the proper handling of materials and reagents. Always follow standard laboratory safety
guidelines. For hazardous substance information, refer to the section: Hazardous Substance
Information.

Intended Use
The RNA 9000 Purity & Integrity kit is for laboratory use only.

Introduction
The RNA 9000 Purity & Integrity kit is designed for biopharmaceutical scientists working on next
generation RNA therapeutics. This kit provides high analytical resolution, helps alleviate method
complexity, and simplifies transferability. The kit has been validated on both the PA 800 Plus and
BioPhase 8800 systems.

The methodology involves heat denaturation of an RNA sample followed by immediate cooling
in an ice water bath. This forces the nucleic acid into the structure that provides the most
consistent mobility during the separation.

The RNA sample is separated by size in a bare-fused silica capillary containing a replaceable
polymer gel that provides sieving selectivity while concurrently limiting counter electroosmotic
flow (EOF). The fluorescent labeling dye SYBR™ Green II RNA Gel Stain1 is added to the

1 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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polymer gel matrix during reagent preparation. The dye preferentially binds to RNA molecules so
that the RNA can be detected by laser-induced fluorescence (LIF) during the separation.

Workflow
Table 1 RNA 9000 Purity & Integrity Kit Workflow

Step To Do This Refer To

1 Prepare the RNA sample at a
concentration between 50 ng/mL to
50 μg/mL.

The RNA preparation procedure for the
laboratory.

2 (Optional) Dilute the ssRNA Ladder with
Sample Loading Solution or nuclease-
free water, denature at 70 °C for 5
minutes, and then cool immediately.

Prepare the ssRNA Ladder

3 Dilute each RNA sample with Sample
Loading Solution or nuclease-free water,
denature at 70 °C for 5 minutes, and then
cool immediately.

Prepare the RNA Sample

4 Install the LIF detector. Install the LIF Detector

5 Load the sample tray. Load the Sample Tray

6 Install the cartridge. Install the Cartridge and Calibrate the
Detector

7 Prepare the gel buffer and load the buffer
trays.

Load the Buffer Trays

8 For PA 800 Plus software users, create
the RNA 9000 instrument and projects.

Create the Example Instrument and
Create the Example Project

9 In the PA 800 Plus software, create a
sequence and then start the run. Make
sure that the sequence ends with the
Shutdown Method - RNA 9000 method.

Create the Sequence and Start the Run

10 After the run, store the cartridge. Store the Cartridge

11 Analyze the data. Analyze the Data

Required Equipment and Materials
Note: For items with a reorder part number, sometimes the reorder quantity is different than the
quantity in the kit.
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Note: The RNA 9000 Purity & Integrity Kit (PN C48231) is packaged as two parts: Nucleic
Acid Extended Range Purity & Integrity Kit (PN 5087900) and ssRNA Ladder (0.05-9 kb) (PN
5088699). Neither part can be ordered separately.

Note: The ssRNA Ladder in the RNA 9000 Purity & Integrity Kit (PN C48231) is shipped
separately from the other kit components.

Table 2 RNA 9000 Purity & Integrity Kit (PN C48231)

Component Quantity Reorder Part
Number

Nucleic Acid Extended Range Purity & Integrity Kit (PN 5087900) N/A

Acid Wash/Regenerating Solution (0.1 M HCl) (100 mL) 1 N/A

CE Grade Water (140 mL) 2 C48034

LIF Performance Test Mix (20 mL) 1 726022

Nucleic Acid Extended Range Gel (140 mL) 2 N/A

SYBR™ Green II RNA Gel Stain2 (500×) (0.11 mL) 7 N/A

ssRNA Ladder (0.05-9 kb) (PN 5088699) N/A

ssRNA Ladder (0.05 kb to 9 kb) (70 μL) (shipped
separately)

2 N/A

Table 3 Additional Supplies from SCIEX

Component Quantity Part Number

(Optional) Capillary Performance Run Buffer A 1 338426

Capillary, bare fused-silica (50 μm i.d. × 67 cm long) 1 338451

Capillary cartridge, blank 1 144738

Capillary cartridge, pre-assembled 1 A55625

Filter, 520 nm emission filter 1 144940

LIF Cartridge Aperture Plug Assembly 1 721125

LIF Cartridge Probe Guide Assembly 1 721126

PCR microvials (200 µL) 100 144709

Sample Loading Solution 6 mL 608082

2 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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Table 3 Additional Supplies from SCIEX (continued)

Component Quantity Part Number

Universal vial caps, blue 100 A62250

Universal vials 100 A62251

Table 4 Additional Required Reagents or Supplies

Description Vendor Part Number

Acrodisc 32 mm syringe filter with a 0.45 μm pore-size
membrane

Pall 4654

Luer-Lok tip disposable syringe (10 mL) BD 309604

(Optional) Nuclease-free water (10 × 2 mL) Integrated DNA
Technologies

11-04-02-01

(Optional) RNaseZap RNase Decontamination Solution
(250 mL)

Thermo Fisher
Scientific

AM9780

Storage Conditions
• Upon receipt, store the following at 2 °C to 8 °C:

• Nucleic Acid Extended Range Gel

• LIF Performance Test Mix

• Upon receipt, immediately wrap the SYBR™ Green II RNA Gel Stain3 in aluminum foil to
reduce photobleaching of the SYBR™ Green II RNA Gel Stain and then store at –35 °C to
–15 °C.

• Upon receipt, store the ssRNA Ladder at –35 °C to –15 °C.

• Store the remainder of the kit contents at room temperature.

Customer-Supplied Equipment and Supplies
• Powder-free gloves, neoprene or nitrile recommended

• Safety glasses

• Laboratory coat

• PCR tubes, 0.2 mL flat-cap nuclease-free (VWR USA PN 20170-012 or VWR EUR PN
732-0548)

3 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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• Table-top mini centrifuge

• Microcentrifuge, or equivalent, and nuclease-free microcentrifuge tubes

• Vortex mixer

• Pipettes and appropriate nuclease-free tips

• Water bath or heat block capable of 37 °C to 100 °C temperature

• Analytical balance

• Ice

Required Detector
A laser-induced fluorescence (LIF) detector with an excitation wavelength of 488 nm and a
520 nm emission filter and the supplies to calibrate it are required. Calibration supplies are:

• LIF Performance Test Mix, included with the kit

• CE Grade Water, included with the kit

Required Cartridge or Capillary
CAUTION: Potential Wrong Result. If a capillary is used with the RNA 9000 Purity &
Integrity kit, then do not use the same capillary for another application. Mixing different
buffers and sample types can cause sample carryover, nonspecific binding, and poor
separation.

One of the following:

• Pre-assembled cartridge (PN A55625)

• Capillary cartridge (PN 144738) and capillaries, bare-fused silica, 50 µm i.d. (PN 338451)

Condition the Capillary
CAUTION: Potential Wrong Result. Do not use a basic solution to clean the capillary
because the solution might negatively ionize the capillary wall and cause nonspecific
interactions with the sample. These interactions might cause poor separation and sample
degradation.

• Before the capillary is used the first time, condition the capillary with the Conditioning Method-
RNA 9000 method.

RNA 9000 Purity & Integrity Kit

Application Guide
RUO-IDV-05-13437-C

RNA 9000 Purity & Integrity Kit For the PA 800 Plus
Pharmaceutical Analysis System

9/53



Methods and Sequences
Download the methods and sequences from sciex.com/products/methods. The methods and
sequences can also be created manually with the 32 Karat software. Refer to the section:
Methods.

Save the methods to the PA 800 Plus controller: C:\32Karat\projects\RNA
9000\Method.

Save the sequence to: C:\32Karat\projects\RNA 9000\Sequence.

At the time of publication, the following methods and sequence are available on the SCIEX
website:

• Methods:

• Conditioning Method-RNA 9000: Conditions the capillary.

• Separation Method - Electrokinetic Injection - RNA 9000: Separates the sample with an
electrokinetic injection of the sample.

• Shutdown Method - RNA 9000: Cleans the capillary at the end of a sequence and turns off
the light source.

• Capillary Rinse - RNA 9000: Rinses the capillary. To save time after the capillary has been
conditioned, replace Conditioning Method-RNA 9000 with this method in the sequence.

• ANALYSIS - RNA 9000 - ssRNA Ladder: Contains the default integration parameters and
named peaks to aid in the analysis of the ssRNA Ladder.

• RNA 9000 Test Sequence - Electrokinetic Sample Injection: A sequence with the separation
method that uses electrokinetic sample injection.

Prepare the Samples
Best Practices for Working with RNA
Controlling RNase contamination is critical to the successful analysis of RNA. Precautions must
be taken to ensure RNA integrity prior to ssRNA ladder or RNA sample separation. RNases are
prevalent on human skin, perspiration, and saliva as well as bacteria and fungi spores and are
therefore ubiquitous to the lab environment. Proper laboratory procedures will help control RNA
degradation from RNases.

1. Wear gloves at all times and change gloves often when handling RNA samples.

2. Designate an RNase-free lab area and use RNase decontaminating reagents such as
RNaseZap RNase Decontamination Solution or MP Bio RNase Erase Decontamination
Solution for bench surfaces, lab racks, and micropipettors. Also, use a lab apparatus
capable of UV-light disinfection to help control RNase contamination.
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3. Dedicate pipettes for RNA use and use filtered pipette tips that are certified nuclease-free to
decrease cross-contamination.

4. For anything that comes into contact with RNA, use nuclease-free plastic vials and labware.
Before adding any RNA, shield plasticware from environmental contamination by covering
and working in areas that limit airflow.

5. Use reagents such as nuclease-free water during RNA sample preparation. Use of Sample
Loading Solution or deionized formamide during RNA sample preparation promotes an
environment that stabilizes RNA and prevents RNA degradation from RNases.

Note: CE Grade Water is not certified as nuclease-free.

Prepare the ssRNA Ladder
Note: Use the ssRNA Ladder as a qualitative reference for estimating the size of an unknown
RNA sample. It is not intended to be a quantitative standard.

1. Prepare the ssRNA Ladder.

a. For the initial run, remove the vial of ssRNA Ladder from the freezer, and then let it
thaw on ice.

b. With a vortex mixer, mix briefly for a few seconds, and then use a centrifuge to spin the
vial for a few seconds to bring the solution to the bottom of the vial.

c. Measure out the solution in 8 μL aliquots into nuclease-free PCR vials.

d. Reserve one aliquot, and then store the remaining aliquots at –35 °C to –15 °C.

2. Use one of the 8 μL aliquots of the ssRNA Ladder. If it is frozen, then thaw it on ice before
use.

3. For every 50 μL of RNA sample, add 2 μL of the ssRNA Ladder to 48 μL of Sample Loading
Solution or nuclease-free water.

4. Heat the sample at 70 °C for 5 min.

5. After 5 min, immediately put the mixture in an ice water bath to cool for a minimum of 2 min.

Note: Rapid cooling forces the RNA into a structure that gives the best separation results.

6. Put a microvial in a universal vial and then put the universal vial in the sample tray.

7. With a pipette, add between 50 μL and 200 μL of the cooled RNA solution to the microvial
then cap the universal vial with a blue cap.

8. Put the sample tray in the system. Make sure that the sample compartment temperature is
set to 10 °C.
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Note: If the LIF laser is not warmed up or the detector has not been calibrated, then do not
put the sample tray in the system. Instead, store the tray between 2 °C and 8 °C while the
laser warms up or the calibration is performed and then put the sample tray in the system.

Prepare the RNA Sample
1. Thaw the RNA aliquot on ice.

Keep the sample cool to help prevent the RNA from degrading.

2. Prepare the RNA sample in Sample Loading Solution or nuclease-free water between
50 ng/mL to 50 μg/mL.
We recommend an RNA concentration between 1 μg/mL and 5 μg/mL.

Note: To use a higher sample concentration, increase the Dynamic range from 100 to
1,000 in the LIF Detector Initial Conditions tab in the separation method.

3. Heat the sample at 70 °C for 5 min.

4. After 5 min, immediately put the mixture in an ice water bath to cool for a minimum of 2 min.

Note: Rapid cooling forces the RNA into a structure that gives the best separation results.

5. Put a microvial in a universal vial and then put the universal vial in the sample tray.

6. With a pipette, add between 50 μL and 200 μL of the cooled RNA solution to the microvial
then cap the universal vial with a blue cap.

7. Put the sample tray in the system. Make sure that the sample compartment temperature is
set to 10 °C.

Note: If the LIF laser is not warmed up or the detector has not been calibrated, then do not
put the sample tray in the system. Instead, store the tray between 2 °C and 8 °C while the
laser warms up or the calibration is performed and then put the sample tray in the system.

Prepare the PA 800 Plus System
Use the procedures in this section to prepare the PA 800 Plus system to acquire data.

The procedures in this section assume that the system has already been correctly installed and
initialized.

Tip! To save time, turn on the light source 30 minutes before the start of the run to let it warm up.

Install the LIF Detector
1. Turn off the PA 800 Plus system and then install the LIF detector. Refer to the document:

System Maintenance Guide.
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2. Turn on the system.

3. Turn on the laser and let it warm up for at least 30 minutes.

Clean the Interface Block
CAUTION: Potential System Damage. Do not let the gel collect on the electrodes,
opening levers, capillary ends, and interface block. Gel accumulation might cause broken
capillaries, bent electrodes, jammed vials, or missed injections.

Clean the electrodes, opening levers, capillary ends, and interface block after every use or when
changing chemistries. For detailed instructions, refer to the document: System Maintenance
Guide.

The gel buffer is very viscous and can collect in the system unless regular and thorough
cleaning is performed.

Install the Cartridge and Calibrate the Detector
Note: To make sure that the analysis results are consistent over time, SCIEX recommends that
the detector be calibrated each time it is installed in the PA 800 Plus system. Also, calibrate the
detector after the capillary in the cartridge is replaced or a different cartridge is installed.

1. Remove the cartridge from the box and, if required, install the capillary.

2. Remove the aperture from the cartridge, and then install the LIF aperture and probe guide
on the LIF detector. Refer to the document: System Maintenance Guide.

3. Install the cartridge in the PA 800 Plus system. Refer to the document: System Maintenance
Guide.

4. Calibrate the detector.
Use the Calibration wizard, available from the Instrument Configuration dialog in the
32 Karat software. For detailed instructions, refer to the section: Calibrate the LIF Detector.
Use the values in the following table in step two of the Calibration wizard.

Note: The Target RFU is 40 so that the signal intensity from the PA 800 Plus system is
almost the same as the signal from a BioPhase 8800 system. It it intended for transferability.

Table 5 Calibration Parameters

Detector Channel 1

Target RFU 40

Capillary Dimensions

Internal Diameter 50 µm
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Table 5 Calibration Parameters (continued)

Total Length 30 cm or 50 cm, based on the length of the
capillary

Load the Buffer Trays
CAUTION: Potential System Damage. Do not fill any vial with more than 1.8 mL of liquid.
Also, do not let more than 1.8 mL to accumulate in the waste vials. If a vial contains more
than 1.8 mL, then the pressure system might be damaged.

Note: To prevent air bubbles, do not shake or vigorously mix the gel buffer. Air bubbles might
cause issues with the separation.

Note: SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel
Stain is not available for resale.

1. Add the reagents specified in the following table to a conical tube and then gently invert the
tube a minimum of 20 times.
While inverting the tube, make sure that no bubbles are formed.

CAUTION: Potential Wrong Result. Do not prepare the gel buffer in advance. The
SYBR™ Green II RNA Gel Stain in the gel buffer might degrade during storage,
causing peaks with decreased intensity.

Table 6 Gel Buffer (Nucleic Acid Extended Range Gel with SYBR™ Green II RNA Gel
Stain)

Reagent For 1 to 8
Samples

For 9 to 16
Samples

For 41 to 48
Samples

Nucleic Acid Extended Range Gel 5 mL 10 mL 30 mL

SYBR™ Green II RNA Gel Stain 10 μL 20 μL 60 μL

Note: The gel buffer and dye mixture is referred to as "gel buffer" in the rest of the
document.

Tip! Wrap the vial that contains the prepared gel buffer in aluminum foil to reduce
photobleaching of the SYBR™ Green II RNA Gel Stain.

2. With a 0.45 μm Acrodisc syringe filter and a Luer-Lok syringe, filter the gel buffer.

3. Put 16 universal vials in the buffer trays as shown in the following figure. Each row is
sufficient for at least eight runs.
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Note: The separation methods are programmed to increment after eight runs. Do not reuse
the vials or caps because they might be contaminated with dried gel or other chemicals. The
vials and caps are designed for a single use.

Figure 1 Buffer Tray Layout for 16 Samples

Note: For fewer than 8 samples, fill only row 1.

4. Fill the vials as shown in the following table. After filling each vial, cap it with a blue cap.
Refer to the figure: Figure 2.

Table 7 Vials to Prepare

Label in
Figure 1

No. of Vials Vol./Vial (mL) Reagent

Water 10 1.5 CE Grade Water

Gel 6 1.5 Gel buffer with SYBR™ Green II RNA Gel
Stain

HCl 2 1.5 Acid Wash/Regenerating Solution

Waste 6 1.0 CE Grade Water
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Figure 2 Universal Vial and Cap Setup

Item Description

1 Universal vial cap

2 Maximum fill line

3 Universal vial

Load the Sample Tray
1. Put each microvial in a universal vial and then put the universal vial in the sample tray. Refer

to the figure: Figure 3.
Position A1 is for the ssRNA Ladder. Use the other positions for the other samples.
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Figure 3 Sample Tray Layout

2. Add the samples to the microvials. For each sample:

a. Transfer between 50 µL to 200 μL of the sample to a microvial.

b. Put a blue cap on the universal vial. Refer to the figure: Figure 4.

Figure 4 Sample Vial Setup
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Item Description

1 Universal vial cap

2 Microvial

3 Universal vial

4 Microvial inside universal vial

Run the Samples
Tips for Best Results
SCIEX tested the separation performance of the ssRNA Ladder and other characteristics over a
range of temperatures. 30 °C is used in the separation methods because it gave the best overall
results.

Other temperatures can be used if a specific characteristic is to be maximized. Refer to the
table: Table 8.

Table 8 Guidance for Setting the Capillary Temperature

Capillary
Temperature (°C)

Capillary Run Life 9 kb Peak
Migration Time

(min)

Optimal Resolution by RNA
Length

3 kb to 5 kb ≥ 5 kb

25 Highest ~21

30 Higher ~20

35 Medium ~19

40 Lower ~17

Note: The capillary run life (the number of injections that can be performed) depends on the
sample and the separation method. The preceding table illustrates how performance changes
based on the capillary temperature. In general, a lower temperature increases the capillary run
life.

Use the Rinse Method
A rinse method is supplied with the other methods for the kit.

To save time after the capillary has been conditioned, substitute the Capillary Rinse - RNA 9000
method for the Conditioning Method-RNA 9000 method in the sequence. The rinse method is
approximately 30 minutes shorter than the conditioning method.
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Create the Example Instrument
Note: The following procedure is required if the PA 800 Plus software will be used for data
acquisition and analysis. If the 32 Karat software will be used instead, then this procedure is not
required.

This procedure requires the user name and password for a user with administrative privileges for
the 32 Karat software.

For detailed instructions, refer to the documents: 32 Karat Software Help or Methods
Development Guide.

1. Double-click the 32 Karat icon on the desktop.

2. Click Tools > Enterprise Login, type the user name and password, and then click Login.

3. Click Tools > System Administration Wizard.

Figure 5 Select Administration Wizard Window

4. Click Instrument, and then click Next.

5. Follow the instructions in the wizard to create the instrument. When prompted for the
instrument name, type RNA 9000.
The PA 800 plus System Configuration dialog opens.
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6. Click LIF Detector, , and then click OK.

7. Do one of the following:

• If the system is connected to the controller and it is turned on, then click Auto
Configuration.

• If the system is not connected to the controller or it is turned off, then in the Configured
modules list, right-click LIF Detector and select Open. Make sure that the trays are
configured correctly, and then click OK.

8. Click OK.
The PA 800 plus System Configuration dialog closes.

Create the Example Project
Note: The following procedure is required if the PA 800 Plus software will be used for data
acquisition and analysis. If the 32 Karat software will be used instead, then this procedure is not
required.

This procedure requires the user name and password for a user with administrative privileges for
the 32 Karat software.

1. Double-click the 32 Karat software icon on the desktop.
If the 32 Karat software is already open, close any instrument windows that are open.

2. Click Tools > Enterprise Login, type the user name and password, and then click Login.

3. Click Tools > System Administration Wizard.

RNA 9000 Purity & Integrity Kit

RNA 9000 Purity & Integrity Kit For the PA 800 Plus
Pharmaceutical Analysis System
20/53

Application Guide
RUO-IDV-05-13437-C



Figure 6 Select Administration Wizard Window

4. Click Project and then click Next.

5. Follow the instructions in the wizard to create the project. When prompted for the project
name, type RNA 9000.
Make sure to assign users to the project.

For detailed instructions, refer to the documents: 32 Karat Software Help or System
Administration Guide.

6. If required, then download the method and sequence files from the SCIEX website. Refer to
the section: Methods and Sequences.

7. Copy the methods to the methods folder for the project. By default, this is C:
\32Karat\projects\RNA 9000\Method.

8. Copy the sequence to the sequence folder for the project. By default, this is C:
\32Karat\projects\RNA 9000\Sequence.

Create the Sequence and Start the Run
1. Double-click the PA 800 Plus software icon on the desktop to open the PA 800 Plus

software.
The PA 800 plus window opens
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2. , click  (Run) in the upper right corner of the window.
The Instrument Status and Direct Control page opens.

Figure 7 Instrument Status and Direct Control Window

3. Click  (Describe).

4. In the Application list, click RNA 9000. In the Sequence list, click Browse, and then
browse to the RNA 9000 Test Sequence - Electrokinetic Sample Injection sequence. If
prompted, type a user name and password.
The page updates to show the selected sequence, and all of the rows in the sequence are
designated as samples.

5. Click the first row to select it, and then click  (Control) in the Rows area.
The first row contains the ssRNA Ladder.
The icon in the Type column in the first row in the sequence changes to a square.

6. Click the last row (with the Shutdown Method - RNA 9000 method) to select it, and then
click  (Always) in the Rows area.
The icon in the Type column in the sequence changes to a triangle.
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Figure 8 Describe sequence rows and columns Window

7. In the lower right corner of the window, click  (Save), and then click 
(Finish).

8. In the Number of samples field, click the arrow buttons to set the number of samples for
the run.

Figure 9 Set the Number of Samples

As the number of samples changes, the images of the buffer and sample trays on the right
are updated to show the correct number of vials and their locations for the run. For example,
in Figure 1, one row of reagents is required for eight samples. Two rows of reagents are
required for 16 samples.
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Figure 10 Tray Map

9. If the buffer and sample trays have not been loaded, then click  (Load), load the
buffer and sample trays in the PA 800 Plus system, and then close the door.

10. Click  (Next), and then click Yes - run now.

Figure 11 Samples Loaded Prompt
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Figure 12 PA 800 Software During Data Acquisition

Waste Disposal
WARNING! Biohazard or Toxic Chemical Hazard. Follow local directives to
dispose of chemicals, vials and caps, and the remains of the prepared
samples. They might contain regulated compounds and biohazardous
agents.

Store the Cartridge
Store the Cartridge for Less Than 24 Hours
1. Use the shutdown method to clean the capillary.

The shutdown method fills the capillaries with CE Grade Water and decreases the cartridge
temperature to 15 °C.

2. Store the cartridge for up to 24 hours in the system, with the capillary ends immersed in
vials of CE Grade Water.

Store the Cartridge for More Than 24 Hours
1. Use the shutdown method to clean the capillary.
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2. Remove the cartridge from the system.

3. Put the cartridge in the cartridge storage box with the capillary ends immersed in vials of CE
Grade Water.

4. Store the cartridge storage box upright in the refrigerator between 2 °C and 8 °C.

Prepare the Cartridge After Storage
• If the cartridge has not been used for more than a day or if it has been stored for an extended

time, then condition the capillary by rinsing it with CE Grade Water for 5 min at 50 psi.

Analyze the Data
Analyze the Data for the ssRNA Ladder
1. In the 32 Karat software, open the sequence from the run.

2. Open the data file for the first run.

3. Click File > Open > Method, select ANALYSIS - RNA 9000 - ssRNA Ladder, and then
click OK.
For reference, the integration parameters and named peaks table are shown in the following
figures.

Figure 13 Integration Parameters

Note: The peak names correspond to the length of the RNA in the ssRNA Ladder.
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Figure 14 Named Peaks Table

4. Adjust the integration events until all of the peaks in the test sample are integrated correctly.
Refer to the chapter: "Integration" in the document: Methods Development Guide.

5. Click File > Save, to save the method and then apply it to the rows in the sequence that
contain the ssRNA Ladder samples.
The electropherogram is labeled with the peak names for the components of the ssRNA
Ladder.

Figure 15 Example Electropherogram for the ssRNA Ladder

Guidance for Developing Acceptance Criteria
Acceptance criteria that are created for use with this kit for SOPs or other purposes should be
based on parameters inherent to the quality of the separation and attributes that reflect critical
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sample qualities. Differences between gel and capillary lots and different systems might lead to
variation in absolute migration times.

For the ssRNA ladder, the ratio between the migration time of the 9 kb and 0.5 kb peaks more
accurately reflects the apparent size of the nucleic acids in the gel and can be used to identify
the resolving power of the separation gel and consistency of the separation. SCIEX strongly
discourages the use of absolute migration time as an acceptance criterion.

Troubleshooting
Note: SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel
Stain is not available for resale.
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Symptom Possible Cause Corrective Action

Broad peaks, poor
resolution

1. The capillary end is damaged.

2. The sample concentration is
too high.

3. The capillary is blocked.

4. The internal surface of the
capillary is contaminated.

5. The lifetime of the capillary
has been exceeded.

6. The SYBR™ Green II RNA Gel
Stain concentration in the gel
buffer is too high.

1. Inspect the capillary ends under
magnification. If a cut is jagged,
then cut the end again or
replace the capillary.

2. Do one or all of the following:

• Dilute the sample again with
the sample diluent.

• Decrease the Duration in
the Inject event in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

3. Replace the capillary or capillary
cartridge.

4. Replace the capillary or capillary
cartridge.

5. Perform a test separation of
the ssRNA Ladder. If the
peak widths are consistently
wider than previous runs then
replace the capillary or capillary
cartridge.

6. Make sure that the SYBR™

Green II RNA Gel Stain is
diluted between 100× and
1000× in the gel buffer. Refer
to the section: Load the Buffer
Trays.
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Symptom Possible Cause Corrective Action

Broad peaks,
poor resolution
(continued)

1. The Nucleic Acid Extended
Range Gel was left at room
temperature too long.

2. The capillary cartridge was
left at room temperature for
more than a week.

1. Prepare fresh Nucleic Acid
Extended Range Gel, making
sure to store it between 2 °C
and 8 °C. Minimize the time that
the gel is at room temperature.

2. Replace the capillary or capillary
cartridge. For the new capillary,
make sure to run the shutdown
method at the end of the day.

Carryover 1. The sample concentration is
too high.

2. The vials or caps are
contaminated.

1. Do one or all of the following:

• Decrease the Duration in
the Inject event in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

• Dilute the sample again with
the sample diluent.

2. Replace the vials and caps or
modify the method:

• Fill clean vials with freshly
prepared reagents, cover the
vials with clean caps, and
then replace the vials in the
tray. Do not reuse vials or
caps.

• Make sure that the waste
vials contain 1.0 mL of water
and are present in the outlet
buffer tray.

• In the separation method,
add one or more water dip
steps after sample injection.
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Symptom Possible Cause Corrective Action

Extra peaks 1. Non-nucleic acid components
of the sample interacted with
the SYBR™ Green II RNA Gel
Stain.

2. The plasticware used
during sample preparation
or the sample vials are
contaminated with materials
that interact with SYBR™

Green II RNA Gel Stain.

3. Light scattering due to
particulates larger than 1 μm
in the gel buffer.

1. Prepare the sample again,
making sure it is pure.

2. Prepare the sample again, using
clean plasticware and clean
sample vials. Do not reuse vials
or caps.

3. Filter the gel buffer with a
syringe filter before adding it to
the buffer trays.

High current 1. The gel buffer is
contaminated.

2. The buffer trays are not set up
correctly.

3. The Nucleic Acid Extended
Range Gel was left at room
temperature too long.

1. Replace the vials and caps with
clean ones. Do not reuse vials
or caps.

2. Make sure that the vials in the
buffer tray contain the correct
reagents and are in the correct
location. Refer to the section:
Load the Buffer Trays.

3. Prepare fresh Nucleic Acid
Extended Range Gel, making
sure to store it between 2 °C
and 8 °C. Minimize the time that
the gel is at room temperature.

RNA 9000 Purity & Integrity Kit

Application Guide
RUO-IDV-05-13437-C

RNA 9000 Purity & Integrity Kit For the PA 800 Plus
Pharmaceutical Analysis System

31/53



Symptom Possible Cause Corrective Action

Low signal 1. The end of the capillary tip is
dirty or plugged.

2. The sample concentration is
too low.

3. The salt concentration in the
sample is too high.

4. The initial nucleic acid
concentration is too low.

1. Replace the capillary or capillary
cartridge.

2. Do one or all of the following:

• Increase the Duration up
to 15 s in the Inject event
in the separation method to
inject more sample. If the
results are not satisfactory,
then increase the Pressure
or Voltage.

• Prepare the sample again,
with the recommended
concentration. The
recommended concentration
is 50 ng/mL to 50 μg/mL.

3. Do one or all of the following:

• If the separation method
uses an electrokinetic
injection, then use a pressure
injection instead.

• Prepare the sample at a
lower ionic strength.

4. Do one or all of the following:

• Increase the Duration up
to 15 s in the Inject event
in the separation method to
inject more sample. If the
results are not satisfactory,
then increase the Pressure
or Voltage.

• Prepare the sample again,
with the recommended
concentration. The
recommended concentration
is 50 ng/mL to 50 μg/mL.
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Symptom Possible Cause Corrective Action

Low signal
(continued)

1. The nucleic acids in the
sample have degraded due
to the presence of RNAse or
other nucleases.

1. Prepare the sample again,
making sure to limit exposure
to RNase. Refer to the section:
Best Practices for Working with
RNA.

Low current 1. The end of the capillary tip is
dirty or plugged.

2. The capillary window or end is
broken.

3. There are dried reagents
on the electrodes, opening
levers, capillary ends, or
interface block.

4. The buffer trays are not set up
correctly.

1. Replace the capillary or capillary
cartridge.

2. Inspect the capillary window
and tip. If either is broken,
then replace the capillary or the
capillary cartridge.

3. Clean the interface block daily
or as needed. Refer to the
section: Clean the Interface
Block.

4. Make sure that the vials in the
buffer tray contain the correct
reagents and are in the correct
locations. Refer to the section:
Load the Buffer Trays.

Low or unsteady
current

1. The end of the capillary tip is
dirty or plugged.

2. The gel buffer has air
bubbles.

1. Replace the capillary or capillary
cartridge.

2. Sonicate the buffer from 10 s to
20 s to remove air bubbles.
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Symptom Possible Cause Corrective Action

No electrical current
during separation

1. The capillary is damaged.

2. An electrode is broken or
bent.

3. The end of the capillary tip is
dirty or blocked.

4. The buffer trays are not set up
correctly.

5. The capillary is filled with air
bubbles.

6. There are dried reagents
on the electrodes, opening
levers, capillary ends, or
interface block.

1. Replace the capillary or capillary
cartridge.

2. Replace the electrode.

3. Replace the capillary or capillary
cartridge.

4. Make sure that the vials in the
buffer tray contain the correct
reagents and are in the correct
locations. Refer to the section:
Load the Buffer Trays.

5. Do one or all of the following:

• Make sure that there is
100 µL of sample in the
microvial.

• Make sure that the vials in
the buffer and sample trays
are in the correct locations.
Refer to the sections: Load
the Buffer Trays and Load
the Sample Tray.

• Sonicate the buffer from
10 s to 20 s to remove air
bubbles.

6. Clean the interface block daily
or as needed. Refer to the
section: Clean the Interface
Block.
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Symptom Possible Cause Corrective Action

No peaks 1. The lifetime of the LIF
detector laser has been
exceeded.

2. The method parameters are
incorrect.

3. There is an air bubble at the
bottom of the sample vial.

4. The capillary window or end is
broken.

5. The sample volume is too low.

6. The sample is missing or not
in the correct position in the
sample tray.

7. The capillary was cleaned
with a basic solution such as
0.1 N NaOH.

8. An end of the capillary
extends beyond the electrode.

1. Contact SCIEX Technical
Support at sciex.com/request-
support.

2. Do the following:

a. Open the separation
method in the software and
then make sure that the
method is correct. Refer
to the section: Separation
Method.

b. Make sure that the
positions of the samples
and reagents in the trays
agree with the tray layouts.

3. Use a centrifuge to spin the
sample tube to make sure that
there are no bubbles at the
bottom.

4. Inspect the capillary window
and tip. If either is broken,
then replace the capillary or the
capillary cartridge.

5. Make sure that there is 100 µL
of sample in the microvial.

6. Make sure that the samples
are in the correct locations in
the sample tray. Refer to the
section: Load the Sample Tray.

7. Replace the capillary or capillary
cartridge.

8. Inspect the capillary ends under
magnification. If an end extends
beyond the electrode, then cut
the end again or replace the
capillary.
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Symptom Possible Cause Corrective Action

No peaks
(continued)

1. A pipetting error occurred
during preparation of the
sample.

2. The salt concentration in the
sample is too high.

1. Do one or all of the following:

• If the separation method
uses an electrokinetic
injection, then use a pressure
injection instead.

• Prepare the sample at a
lower ionic strength.

2. Prepare a new sample.

Slower migration
time with or without
concurrent low
current

1. The end of the capillary tip is
dirty or plugged.

1. Replace the capillary or capillary
cartridge.

Dramatic shift in
migration time
between runs on the
same day

1. The capillary has not been
conditioned sufficiently.

2. The gel buffer has
evaporated.

1. Condition the capillary. Refer
to the section: Condition the
Capillary. Do a blank separation
run to equilibrate the capillary
surface.

2. Fill clean vials with freshly
prepared reagents, cover the
vials with clean caps, and then
replace the vials in the tray. Do
not reuse vials or caps.

Spikes in
electropherogram

1. The gel buffer has air
bubbles.

1. Sonicate the buffer from 10 s
to 20 s to remove air bubbles.
If air bubbles are still present,
then prepare fresh gel buffer. Do
not mix the buffer with a vortex
mixer, instead invert the tube
gently a minimum of 20 times.
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Symptom Possible Cause Corrective Action

Broad or split peaks 1. After the denaturation step,
the nucleic acid sample still
has secondary structure.

2. The cooling step after
denaturation was too slow.

3. The SYBR™ Green II RNA Gel
Stain concentration in the gel
buffer is too high.

4. The lifetime of the capillary
has been exceeded.

1. Dilute the samples with Sample
Loading Solution instead of
nuclease-free water.

2. Cool the samples immediately
to prevent the formation of
secondary structure.

3. Make sure that the SYBR™

Green II RNA Gel Stain is
diluted between 100× and
1000× in the gel buffer. Refer
to the section: Load the Buffer
Trays.

4. Do a test separation of
the ssRNA Ladder. If the
peak widths are consistently
wider than previous runs, then
replace the capillary or capillary
cartridge.

Saturated peaks 1. In the LIF Detector Initial
Conditions for the separation
method, the Dynamic range
is too small.

2. The sample concentration is
too high.

1. Increase the value for the
Dynamic range.

2. Do one or all of the following:

a. Dilute the sample again
with the sample diluent.

b. Decrease the Duration in
the Inject event in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

Unstable baseline 1. The concentration of dye in
the inlet buffer tray is not the
same as the concentration in
the outlet buffer tray.

1. Make enough gel buffer for both
the inlet and outlet buffer trays.
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Hazardous Substance Information A
The following information must be noted and the relevant safety measures taken. Refer to the
respective safety data sheets for more information. The safety data sheets are available upon
request or can be downloaded from our website, at sciex.com/tech-regulatory.

Hazard classification according to HCS 2012.

Acid Wash/Regenerating Solution (0.1 M HCl)

DANGER! Causes severe skin burns and eye damage.

SYBR™ Green II RNA Gel Stain4

WARNING! Combustible liquid. Causes skin irritation.

Other Reagents

These components are not classified as hazardous:

• CE Grade Water

• LIF Performance Test Mix

• Nucleic Acid Extended Range Gel

For reagents from other vendors, read the safety data sheet from the vendor before use.

4 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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Methods B
Capillary Conditioning Method
Figure B-1 Initial Conditions Tab
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Figure B-2 LIF Detector Initial Conditions Tab

Figure B-3 Capillary Conditioning Method Time Program Tab
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Separation Method
Figure B-4 Initial Conditions Tab
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Figure B-5 LIF Detector Initial Conditions

Figure B-6 Separation Method Time Program Tab for Electrokinetic Injection
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Shutdown Method
Figure B-7 Initial Conditions Tab
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Figure B-8 LIF Detector Initial Conditions Tab

Figure B-9 Shutdown Method Time Program Tab
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Capillary Rinse Method
Figure B-10 Initial Conditions Tab
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Figure B-11 LIF Detector Initial Conditions Tab

Figure B-12 Capilllary Rinse Method Time Program Tab
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Calibrate the LIF Detector C
Calibrate the LIF detector after installation of a new capillary or a different cartridge, or after
installation of the LIF detector.

Reagent

• LIF Performance Test Mix

• Capillary Performance Run Buffer A

• CE Grade Water

1. Turn off the PA 800 Plus system, and then install the LIF detector.

2. Turn on the PA 800 Plus system, and then let the laser warm up for at least 30 minutes.

3. Open the 32 Karat software.

4. Click Tools > Enterprise Login, and then log in as a user with Administrative privileges.

5. Click the RNA 9000 instrument icon, and then right-click Configure > Instrument.
The Instrument Configuration dialog opens.

6. Click Configure.
The PA 800 Plus System Configuration dialog opens.

7. In the right pane, click the LIF Detector icon, and then right-click and select Open.
The PA 800 plus System Instrument Configuration dialog opens.
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Figure C-1 PA 800 plus System Instrument Configuration Dialog

8. Click LIF Calibration Wizard.

9. Do the calibration.

a. Click Auto, and then click Next.

b. Type 40 in the Target RFU field.

c. Make sure that the values in the Capillary dimensions area are correct, and then click
Next.

Calibrate the LIF Detector
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Figure C-2 Calibration Wizard - Step 2

10. Fill the vials and start the calibration.
For vial positions, refer to the figure: Figure C-3.

a. Put a universal vial in the Buffer position, fill it with 1.5 mL Capillary Performance Run
Buffer A, and then put a cap on the vial.

b. Put a universal vial in the Calibration mix position, add 1.5 mL of LIF Performance Test
Mix diluted 1:1 with CE Grade Water, and then put a cap on the vial.

c. Put a universal vial in the Waste position, fill it with 1.0 mL CE Grade Water, and then
put a cap on the vial.

d. Click Next.
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Figure C-3 Calibration Wizard - Step 3

When the calibration is finished the Calibration Wizard - Step 4 dialog opens.

11. Examine the value for Calibration Correction Factor to evaluate the results.

• If the number is less than 10, then the calibration is successful. Click Accept to save the
results and close the Calibration wizard.

• If the number is greater than 10, then click Cancel, and then refer to the section: CCF
Values for LIF Detector Calibration.

Figure C-4 Calibration Wizard - Step 4

Calibrate the LIF Detector
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12. Use Direct Control to set the sample storage temperature to 10 °C.

CCF Values for LIF Detector Calibration
Reported CCF Value Action

Less than 0.1
or

System performance is
not acceptable

• Make sure that the correct capillary was used, and that it is not
broken.

• Make sure the laser output for the laser in use on the PA 800 Plus
system.

• Make sure that the correct filters are installed in the LIF detector.

• Excitation: 488 nm

• Emission: 520 nm

• Replace the test mix, buffer, and capillary, and then repeat the
calibration. If the problem persists, then contact SCIEX Technical
Support at sciex.com/request-support.

Between 0.1 and 10.0 There is no problem with the system. Run a standard and make sure
that the system performance is satisfactory.

Greater than 10
or

System performance is
not acceptable

• Make sure that the laser output for the laser in use on the PA 800
Plus system is correct.

• Make sure that the correct filters are installed in the LIF detector.

• Excitation: 488 nm

• Emission: 520 nm

• Replace the test mix, buffer, and capillary, and then repeat the
calibration. If the problem continues, then contact SCIEX Technical
Support at sciex.com/request-support.
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Contact Us

Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX Now Learning Hub

Purchase Supplies and Reagents
Reorder SCIEX supplies and reagents online at store.sciex.com. To set up an order, use the
account number, found on the quote, order confirmation, or shipping documents. Currently,
customers in the United States, United Kingdom, and Germany have access to the online store,
but access will be extended to other countries in the future. For customers in other countries,
contact a local SCIEX representative.

SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists
located throughout the world. They can answer questions about the system or any technical
issues that might arise. For more information, visit the SCIEX website at sciex.com or contact us
in one of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

CyberSecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supercedes all previous versions of this document.

To see this document electronically, Adobe Acrobat Reader is required. To download the latest
version, go to https://get.adobe.com/reader.

Contact Us
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To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

To find hardware product documentation, refer to the documentation that comes with the system
or component.

The latest versions of the documentation are available on the SCIEX website, at sciex.com/
customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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